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Introduction
SoilFluxPro™ software (formerly FV8100) is a multi-platform application designed to 
view and analyze data files for both chamber and continuous measurements generated 
by the LI-COR LI-8100 Automated Soil CO2 Flux System. 

SoilFluxPro offers a very convenient way to view selected quantities or summaries of 
these files, as well as quickly plot meaningful analyses that let you evaluate the mea-
surements. Editing and recomputations are also easily done. 

Open a File

Curve Fit Details

Create a .kml File 
for Google Earth

Surface

How to Group 
Plotted Data



Introductory Tour

FV8100 ver 4.0 Page 3

 Introductory Tour

1. Launch SoilFluxPro
When run, SoilFluxPro presents you with and empty Main Window and three tool bars. 
For each LI-8100 data file you open, this view will create a tab sheet for that file, and dis-
play a Summary View. 

A tab and Summary View for 
each file opened.

Tool Bars can be 
dragged around and/or 
detached. 
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2. Open a Data File
Normally, you would click the Open button, and pick an LI-8100 data file. Note that there 
are also several sample files located under Sample files in the File menu; we’ll select 
the survey example. 

3.  The Summary View
Each observation in the data file is shown on one line in the summary view. In the exam-
ple here, 10 observations from an LI-8100 with a survey chamber were read in. Each 
observation is represented by 1 line, showing selected variables (Label, Obs#, etc.) from 
that observation. 

Summary View

Action log
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4. Setting the Displayed Variables
The variables that are displayed for each observation can be selected by you. Click on 
the Display button, to bring up the dialog for changing them.

5. Zoom in on one Observation (Method 1)
We now illustrate how to “zoom in”, and look at the details of an observation. 
Double click one of the observations (lines) in the Summary View to open the Observa-
tion Details. In this view, we can see all the header, measured, and footer variables. The 
window opened by double clicking “belongs” to that observation; if you double click 
another observation, you get another window for that observation.

Click and drag to add items from left list to right list. Also, click and drag items in the right hand 
list to rearrange them. To delete items from the right hand list, highlight them and click the trash 
button. This dialog is discussed in more detail in Change Displayed Variables.
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Double Click

The “As Read” and “Current” tabs pro-
vide text views of the observation. “Cur-
rent” is editable; changes are kept (and 
recomputed) via the Keep button.

“Recompute” provides more user-
friendly front end for recomputing an 
observation. 

The “Fit” tab(s) show the curve fit details for 
the observation, and provides some tools and 
controls for tweaking it.
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6. Zoom in on an Observation (Method 2)
A second method for seeing details of an observation is to open the Details window. This 
window does not belong to any one observation, but rather shows the first highlighted 
observation, or (if there are none) the first observation in the active summary view. You 
can use this to quickly step through a series of observations viewing the curve fit, for 
example. 

Always shows the first selected observation in the active view.

Press 

Press 
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7. Make a Chart
Next, we will demonstrate charts. Click the Add Chart button. 

2. Click on Favorites and 
select “Survey Sequence” 
from the Favorites menu. 
The dialog should change 
as shown below.

1. You are presented 
with an empty plot defi-
nition.

3. Click OK to draw 
the chart.

4. You can double 
click on the chart to 
bring back the Setup 
Dialog.
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When the “Observations:” setting in the setup dialog is “Selected or All”, and “Auto 
update” is checked, then the chart will update anytime a selection change is made in the 
summary view, as illustrated below: 
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Suppose we want to superimpose the Cdry vs. time curves. Double click the chart to 
bring up the setup dialog for it, and modify it like this:

1. Double click the chart

2. Change the bottom axis to 
Etime (elapsed time during the 
observation, and it lives in the 
Measured submenu).

3. Change the Cdry symbol to 
‘-none-’, and Style to ‘Lines’.

4. Set grouping for both variables 
to “Observation”

5. Move Legend to the right.

6. Click OK
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Note that legend entries are clickable buttons: Click to make that entry disappear from 
the graph, and click again to make it reappear. 

Clickable buttons

Button down = hidden
Button up = visible
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Summary View

Open a File

Import Data From an LI-8100

Save a File

Create an Empty View

Export Data

Recompute Observations

Change Displayed Variables

Compute Statistics

Add a Chart

Create a .kml File for 

Transforming Columns

Move Observations 
Between Views

Observation Details
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Open a File Summary View
SoilFluxPro can read both Chamber and Continuous measurement types. Both mea-
surement types can reside within the same file. Also, it really doesn’t matter what the 
extension type (.81x, .csv) is for a file. 

1. Click Open on the tool bar, or select Open in the File menu

2. Use the Open file dia-
log box to navigate to the 
desired directory, and 
select the file(s) to be 
opened.

Note that SoilFluxPro can 
read both.csv and .81x file 
types.

Note: You can select multiple files. Use <ctrl> + click to select 
individual files, or <shift> + click to select a range. If multiple 
files are selected when you click Open, you are given a 
choice of combining them all into one view, or keeping them 
separate

When multiple files are com-
bined, each observations 
retains its original File Name.

Item# indicates the order of 
the observation as read from 
the file. Type indicates the 
type of data, Chamber or Con-
tinuous.

The illustration to the right 
combines three files into one 
view.

1

2

3
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 Import Data From an LI-8100 Summary View
SoilFluxPro can read data files directly from an LI-8100. 

1. Click the Acquire button on the tool bar, or select it from the File 
menu.

2. Specify IP address if using Ethernet, 
or select the comm port if using RS-232.

3. Click the Connect to LI-8100 button. You should get a file list.

Try this if the file list doesn’t 
appear.

If the LI-8100 just powered 
up, the pump may be run-
ning. This will stop it.
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4. Select the file(s) to down-
load.

5. Specify the destination 
directory.

6. Click Download.
Deletes selected files.
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Save a File Summary View
Click on the SaveAs button, or select Save As... from the File Menu.

File Suffixes Save a File
You can type any suffix (e.g. .81x, .txt, .junk, etc.) that you wish on the file name. If you 
leave a suffix off, the program will automatically append the one showing in the filter box. 

File Delimiters Save a File
The save dialog filter box also determines what delimiter character is used when the 
observations are written. Note that SoilFluxPro can read files with any combination of 
continuous or chamber measurements with any of these delimiters: tab, comma, or semi-
colon. Delimiters must be consistent within an observation, but can be different from one 
observation to the next within a file. When SoilFluxPro writes files, however, it will use a 
consistent delimiter throughout the file.

Controls the delimiter character, 
and the default file name suffix 
(used only if you don’t type one). 
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Export Data Summary View
Summary-style data (one observation per row) can be written to a text file, for input to 
spreadsheet or text editing applications.

Change Displayed Variables Summary View
1. Click on the Display button, or select Display from the View menu.

2. The Selecting Variables Dialog (next) is used for this.

1. Click on the Export button, or select Export from the File Menu.

Export a different set of variables. Click 
Define... to set (Selecting Variables Dialog). 
The default “other” list is in the Default Export 
File List (See Preferences).

2. Select the fields to export. These can be the same as the 
Summary View, or you can define a different set.

3. The results can be saved to a file, or copied to the clipboard for pasting into other 
applications.
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Selecting Variables Dialog Change Displayed Variables
Anytime a list of SoilFluxPro variables needs to be defined, such as when selecting vari-
ables to display in the Summary View, or selecting variables to print or export, the follow-
ing dialog is used:

More information about the structure of LI-8100 files and what these variables are can be 
found in SoilFluxPro Definitions.

Footer Items. Gas # 
refers to which flux col-
umn to use. Usually this 
is 1. If you add flux com-
putations, there will be 
more columns.

Measured Items. You can 
select IV (initial value), Mean 
or Range.

Miscellaneous items.

Drag items from the left 
list to the right list to 
include them.

Drag item in the right list 
up and down to arrange 
them

Read / Write right-hand list 
from / to a file. Remove selected 

items from list.

The list of potential variables is divided into 4 lists: Header, Footer, Measured, and Miscellaneous.
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Move Observations Between Views Summary View
Selected observations in the Summary View can be Copied, Cut, and Pasted. Observa-
tions are selected by clicking on them. Note that <ctrl> click selects multiple observa-
tions, and <shift> click selects a range of observations. See also Create an Empty View. 

Create an Empty View Summary View
Sometimes it is useful to create an empty view, such as to create a destination for obser-
vations that you will paste in from other views (Move Observations Between Views). Cre-
ating an empty view is done by selecting New from the file menu or tool bar.

The new tab sheet is titled “unnamed”
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Sort Observations Summary View
Click on the column header you wish to use for sorting. Click again to change sort direc-
tion.

1. Enable sorting by right clicking in the 
content area of a Summary View.

2. When sorting is enabled, you can sort 
by a column by clicking in the column 
header.

To reverse the direction of sort, click 
again in the header.
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Add a Chart Summary View

Defining the variable associated with a vertical or bottom axis is done as shown: 

Click on the Add Chart button, or select 
Add Chart from the View Menu.

Click here to add a verti-
cal axis...

...then click here to 
define a horizontal axis.

Or click here and select 
from a list of pre-defined 
graphs.

1. Use the drop down menu 
to select the variable. Most 
are grouped in submenus. 
Here, we are selecting Date.

2. Items from the Mea-
sured menu have a 
secondary selection: 
IV, Mean, and Range 
have one value per 
observation, while the 
“All” selection refers to 
all of the Type=1 val-
ues. 

Footer items also have a sec-
ondary selection, although it is 
usually 1. If you have added 
more flux computations, then 
this is how you get to them.
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The vertical axis definition includes which variable to plot, which axis, symbol, curve 
type, and grouping information. 

How to Group Plotted Data Add a Chart
To illustrate grouping, we will use a data file with 9 multiplexed ports. (If you wish to follow 
along, the SampleMultiplex file under File -> Samples can work, although it is trimmed 
down to 4 ports.) The first graph shows flux as a function of time, with no grouping. 

No grouping, so all observations are lumped 
into one category: the variable being plotted.
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Next, we do a simple grouping by observation. 

Grouping can also occur via one or more tests. In this next example, we examine Port#, 
treat it as an integer, and combine data sets with like port numbers together, naming then 
Port=. 

When grouped by observation, each observa-
tion appears in a different color, and as a sepa-
rate entry in the legend.

Use an asterisk (*) to 
include the Z value in 
the group label.



Summary View

FV8100 ver 4.0 Page 24

Finally, we combine the data into two groups: between rows and within rows, based on 
the Label in each observation. 

Test #1: If Label contains the word 
‘within’, put it in this group.

Test #2: If Label contains the word 
‘between’, put it in this group.
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Setting the Color Sequence Add a Chart
The sequence of colors used in Charts is automatic, but you can modify that sequence 
with the Color Sequence Dialog.

Rearrange the entries by 
click and dragging vertically.

Pick a color, and 
add to the list.

Double click to edit an item.
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Create a .kml File for Google Earth Summary View
 If GPS data is contained in the observation, then a .kml file can be created.

1. Check the observa-
tions to be included. 
This list will only show 
observations that 
have Latitude and 
Longitude data.

2. Select which sorts 
of markers you wish 
to have drawn

3. Select how the data 
should be grouped.

This list is user definable. 
To edit a definition, high-
light it and click the View/
Edit button.
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a) Single marker (merged observations) showing average location of all 10 observations.

b) To put a marker at each observation, do not merge them.

c. Each obs location marked with a 3D column, height proportional to flux.
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With continuous measurement (for example, the SampleSniffer.csv file in the File -> 
Samples menu), the Path marker is probably the most interesting to use. 

The 3D path has a height (m) that is computed 
from the CO2 at each point - 360.
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Group by Observation or Marker Create a .kml File for Google Earth
The following illustrates the difference between the option to group by observation, and 
group by marker.

There’s a column check box, and a 
marker check box. Under each are 10 
check boxes for each observation loca-
tion.

Each of the 10 observations has a check 
box, and under each is a check box for 
the column and one for the marker.
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Compute Statistics Summary View
 

1. Click on the Statistics button, or 
select the Statistics item from the View 
menu.

2. Pick the list of variables on which to 
compute statistics. It can be the same 
as the Summary View list, or you can 
pick a different set (Selecting Variables 
Dialog).

Once you click Compute, the results 
will be shown in a window. This sum-
mary table can be saved as a text file, 
or printed

Save allows you to write the contents with tab delimiters to a text file.

Copy to clipboard puts that same content into the PC’s system clipboard, 
allowing you to paste it into other applications, such as spreadsheets. 
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Recompute Observations Summary View

1. Click on the Recom-
pute button, or else 
select Recompute from 
the Edit menu.

2. In the Recompute Dialog, select the thing(s) you wish to 
change. In the example below, we are changing the Offset 
(collar height parameter), which will change the total volume, 
and thus the flux.

If you wish to redo the curve fit, 
or set all the start/stop times 
the same, you can check the 
appropriate boxes in the Flux 
Calculations area.

3. Click OK, and the observation(s) will be recomputed, and the results displayed in a 
summary window.
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Recompute Options Recompute Observations
The figure below indicates the various options available when recomputing. 

Compute Targeted Flux Recompute Observations
The LI-8100 computes flux at the concentration present when the chamber closed. Soil-
FluxPro supports additional flux computations at other targets based on the slope of the 
exponential fit of Cdry vs. Etime. To compute the rate of change of Cdry at a particular 
target concentration Ct, we first solve the Exponential Fit expression for time tt such that 

. Since

Changing any of these constants will change 
the total volume, and thus the flux.

You can specify the column to use 
for chamber air temperature.

This would only be necessary if you eliminated 
some raw records from the observation.

Redo the Cdry vs. Etime curve fit.

Adjust start and 
stop times for the 
curve fit.

Dilution correction 
not an option for 
Cdry, since it is 
already corrected.

See Compute 
Targeted Flux

Fluxes of Additional Gasses.

C tt( ) Ct=
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(1)

(2)

The rate of change of Cdry at time tt is then

(3)

Targeted flux is computed using this slope. The target can be a user-entered value (Tar-
get), and the flux at this value is Flux@Target. SoilFluxPro also computes the minimum 
Cdry value during chamber closing (MinCO2), and the flux at that target value 
(Flux@Min). Target can be specified in the Recompute Observations dialog.

Fluxes of Additional Gasses Recompute Observations
The LI-8100 computes flux for Cdry, the water corrected CO2 concentration. You can 
add additional fluxes for other gasses that are recorded during the measurement (e.g. 
use the H2O values, or use signals from an external gas analyzer that were recorded by 
the LI-8100 in a spare channel). See Version 3.2 Footer for where the results reside.

Ct C Co C– e
a– tt to– 

+=

tt
1
a
---

Co C–

Ct C–
--------------------
 
 
 

ln to+=

t


C tt( ) a C Co– e
a– tt to– 

=

1. To add a flux computation, 
click the add button.

2. Then specify the column 
label for the data to be used 
for this gas. If you had meth-
ane data logged in V2, then 
you would use that. In this fig-
ure, we’re using the H2O col-
umn to compute a water flux. 

3. If the data needs to be cor-
rected for water vapor, specify 
the column to use for water 
vapor (typically H2O). Also, 
specify how to convert the 
water data in that column to 
units of mol/mol. (If you used 
H2O, which is in mmol/mol, 
then the multiplier is 0.001.

4. If you want a targeted flux 
value, specify the target here.
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Transforming Columns Summary View
The measured data columns can be can be mathematically transformed, using one of 
the following:

(4)

where Z are the values in the column to be transformed, a, b, and c are user entered 
constants, and X and Y are also column values (can be same as Z), but can also be any 
other value in the observation.   

Z a X b+ =

Z aX bY c+ +=

Z a X b+  Y c+ =

Z a
X b+ 
Y c+ 

-----------------=

Use the transform dialog to select the transforma-
tion and column, the source column(s) or values, 
the constants, and the format for writing the 
results.

The example here shows how to replace the 
Tcham column with an average of temperatures 
in columns T2 and T3.

The destination Z is always a column.

X and (if needed) Y can be columns or 
any other value from the obs. If it is not 
a column, then the single value is used 
for all column values.
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The preview button applies the transform to the first file in the potential list and shows the 
results in a view; it does not change the observational data.

Importing Columns Summary View
Data collected and stored in a separate file by another gas analyzer running in parallel 
with the LI-8100 can be imported into the LI-8100 data file, and fluxes computed from it. 
The methodology is to scan the external file(s) for the observations need based on the 
time stamps in the LI-8100 file. The figure below illustrates the process.
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The Column Import routine 
adds selected columns to 
LI-8100 files (right) from 
data extracted from a sepa-
rate gas analyzer file (bot-
tom) based on time stamp. 

For each LI-8100 record, 
an external record is found 
(or interpolated if neces-

For example, the above LI-8100 record at 09:28:55 would import selected columns from the external 
file from a Los Gados Research instrument, interpolated from its 09:28:54.003 and 09:28:55.039 
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To perform a Column Import, click the Column Import tool bar button, and the following 
dialog will appear.

Step 1. Select the file 
format of the source 
file(s) to be imported

Step 2. Add the source 
file(s) to the source list.

The label line, and first obser-
vation line from the first file in 
the source list.

The expected format for an 
LGR file. ok means that’s what 
was found, Error means it 
wasn’t found.

The list of data columns found in the first source file, when parsed according to the above 
expected formats. 

Step 3. Check the columns you wish to import. Note that column(s) used for time and date are 
shown here, but are not checkable.
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Once the columns are imported, you can view them in the summary view, plot them, or 
use them to compute fluxes.

Imported col-
umns in the 
Display Editor. 
Drag to add 
them...

...to the Summary View.

Setting up a flux computation 
with an imported column.
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 Observation Details
To see Details for an observation, double click on that observation in Summary View. 
This open’s a view that “belongs” to that observation, updating automatically whenever 
something changes in that observation (e.g. recompute). Alternatively, click the Detail 
View tool button, and see the detail view of whatever observation happens to be high-
lighted in the active Summary View. Confused? See Zoom in on one Observation 
(Method 1) and Zoom in on an Observation (Method 2). 

As Read s a read-only text view of 
the observation as it was last read 
from a file.

Current an editable view 
of the observation in it’s 
current state.

Measurements shows raw and 
summary records in a table.

Curve Fit Details shows curve fit-
ting details.

Recompute this observation.
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Current Observation Details
The Current tab shows the observation in text form in its present form, including any 
changes due to recomputations, column transformations, etc. This view is editable, so 
any sort of editing is possible. The Keep button will rescan the text, just as if it were read-
ing from a file. This does not change the original (Current), so any changes you make (as 
well as any recomputations, etc.) can always be undone by pressing the Revert to Origi-
nal button.   

To change Area, Volume, and/or Label for multiple observations all at once, see Recom-
pute Observations
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Warnings and Messages Observation Details
Warnings can be generated by the LI-8100 during the measurement; these are stored in 
records whose Type value is -1. There were put into the file at the time measurements 
were taken, and typically say something about a measurement condition, such as high 
humidity, or the measurement was restarted, etc. In addition, SoilFluxPro itself can gen-
erate messages at the time an observation is read. The list of possible messages are 
shown below. 

SoilFluxPro Message Explanation

File Name: missing from 
header

The label ‘File Name:’ was not found, but subse-
quent records were. 

ERROR: Failed to find mea-
sured data labels

The line that identifies measured columns “Type 
Etime Date...” was missing.

Old version. Updating format. The original file is an older version format.

Adjusting dead band and 
Crv_Domain...

This would typically be caused by all or part of the 
observation’s footer missing.

Warning: Chamber never 
closed?

Elapsed times never reached values > 0.

Summary Records and Footer 
not found

The file ended without any summary records or 
footer.

Footer not found No footer was found in the file.



Observation Details

FV8100 ver 4.0 Page 42

Measurements Observation Details

Text
The Measurement tab sheet shows all of the raw records for this observation under the 
Text tab. 

The IV, mean, and range are found by scrolling to the bottom.
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Surface Observation Details
For Continuous measurements that have GPS data, the Surface tab allows spectro-
graphs and contours to be plotted on the surface of your choice.

Which data 
column to plot

Min and Max of 
intensity scale

# Grid lines used 
each dimension

R

G

B

Determines color map 
transition points

# contour intervals 
between Min and Max

Resulting contour spacing 
in units of plotted variable.
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Note the partition control below: sliding it to the left will cover the setup controls. 
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The clone button will make a standalone window out of the surface graph and controls. 
The cloned window retains all the controls except being able to change the variable that 
is plotted. The window is also autonomous from the SoilFluxPro observation or it’s detail 
window that created it. If you delete the source observation from a view, the detail win-
dow also goes away, but not this cloned view. 

Using clones can let you compare multiple variables from the same observation.
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Recompute Observation Details
The Recompute tab in the Detailed View provides a mechanism to recompute just the 
target observation. The interface is very similar to that provided in Recompute Observa-
tions; the only difference is that from here, the recomputation is focused on one particular 
observation. 

For details on using this interface, see 
Recompute Observations
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Curve Fit Details Observation Details
The Fit tab in the Observation Details view provides a close look at the exponential and 
linear fits for an observation. 

Stop time (click and drag)Start time (click and drag)
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Changing Start/Stop Times Curve Fit Details
Click and drag the green Start (left vertical) line, or the red Stop (right vertical) line. When 
you release the mouse button, the data between the lines are linearly and exponentially 
fit, and the results shown in the grid above the chart. This doesn’t actually change the 
observation, unless you click the Keep button.

Flux for this observation, and flux with the 
with the adjusted start/stop times

You can also use these controls, 
then click on Compute.

Click and Drag

Update this 
observation.

Undo your 
changes
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Manually Set Co Curve Fit Details
Usually, Co, the starting value of Cdry, is determined from the IV value of Cdry. You can 
manually override this by unchecking the “The Manually Set Co” check box, and clicking 
and dragging the blue horizontal line to the desired value. This normally is not necessary, 
but is available for strange data sets such as is shown below.

In the figure is typical of non-standard chambers that do not close, but rather just starts 
sampling, resulting in a “catch up” period. The software picked a value for Co of 659.8 
(the blue line, left figure). 

The right hand figure has the “Manually Set Co” box checked, and the blue line has been 
dragged up to a more reasonable-looking value of 950.

Manually set Co value are marked with an asterisk, as seen above and in the Footer.

Check box, then click and drag blue line
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Start/Stop Guidance Curve Fit Details
The Guidance tab provides some “automated” tools for assessing start and stop times.   

The Start Times plot shows 
Flux as a function of Start 
time (given the current Stop 
time). 

The Stop Times plot shows 
Flux as a function of Stop 
time, given the current Start 
time.

The Slope Analysis shows 
the slope of an exponential fit 
of data in a moving band 
between the current Start and 
Stop times. In general, you try 
to work in the region where 
this changes linearly with 
CO2. 
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Miscellaneous Topics

LI-8100 Data File Format Miscellaneous Topics

Chamber Measurements LI-8100 Data File Format
LI-8100 chamber measurement files consist of lines of tab-delimited text that constitute 
one or more Observations. One observation is illustrated below:

Header. The lines from “LI-8100:” through “Labels_01:”.

Type. The first item in each measurement record is the Type: 

Type Description

-1 Warning record

Chamber Measurement, Version 2+ Format 

LI-8100:      199       92     4593      23a      192
File Name: jmw2
Instrument Name:UNKNOWN
Serial Number:81A-0109
Software: 2.a.12
Comments:
Obs#: 1

: <several lines removed>
V4 Info: 0 M=1 B=0
Labels_01: 28
Type Etime Date Tcham Pressure H2O CO2 Cdry
1 -1 2006-01-10 12:04:410 97.65 4.768 634.51 637.55
1 -1 2006-01-10 12:04:420 97.59 4.781 633.96 637
1 0 2006-01-10 12:04:430 97.52 4.75 627.32 630.31

: <several lines removed>
1 89 2006-01-10 12:06:120 97.47 4.616 634.87 637.82
2 0 2006-01-10 12:06:120 97.5 4.704 622.51 625.45
3 44.5 2006-01-10 12:06:120 97.48 4.621 632.48 635.42
4 89 2006-01-10 12:06:120 0.06 0.146 16.96 17.03
CrvFitStatus:Lin
Exp_Flux: 0.000000
Exp_FluxCV:19.900000
Exp_dCdry/dt:0.048000
Exp_R2: 0.223300

: <several lines removed>
Lin_SSN: 5.3384
Lin_SE: 0.0090
Crv_Domain:90
Crv_#Smp: 90
Dead Band: 00:00
TimeClosing:2

Header

Raw Records

Summary Records

Footer

SoilFluxPro version 3.2 and above has a slightly modified Footer for-
mat. See Version 3.2 Footer.
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Raw Records. A record of Type = 1. These represent measured data from the time the 
chamber starts to close, to the when it starts to open.

Summary Records. A record of Type 2, 3, or 4. An Observation has one of each.

Footer. The results of the analysis, including flux values. The footer won’t be present for 
files logged with the “Compute Flux” option off, or for Version 1 files (below). However, 
SoilFluxPro will regenerate the footer.

Observation.  The Header + n Raw Records + 3 Summary Records + the Footer.

1 Raw record

2
Initial Value (Regressed from first 10 
seconds of ETime>=0 data))

3 Mean Value (of ETime >= 0 data)

4 Range Value (of ETime >= 0 data)

Type Description
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Version 1 Formats LI-8100 Data File Format
The Version 1 format (pre-multiplexer) is illustrated below. 

The big difference is lack of a Footer; all of the results are buried in the summary records, 
in extended columns. There are also Header differences, and version 1 files may have 
“missing” headers in subsequent Observations within a file.

When SoilFluxPro reads Version 1 formatted files, they are automatically converted to 
Version 2 format.

File Name: Fc021904east3
Instrument Name: Beta-4
Serial Number: Proto-5
Software: 0.3.21
Observation Length: 02:00
Observation Delay: 02:00
Dead Band: 00:30
Comments:
Labels_01: 10
Labels_234: 19

1 1 4A5X 0 2004-02-19 14:26:3122.1394.16
20.808 462.6 472.43
1 1 4A5X 1 2004-02-19 14:26:3222.1494.17
20.873 464.87 474.78
1 1 4A5X 2 2004-02-19 14:26:3322.1594.17
20.941 465.32 475.27
1 1 4A5X 3 2004-02-19 14:26:3422.1694.16
21.024 467.67 477.41
1 1 4A5X 4 2004-02-19 14:26:3522.1794.17
21.077 468.86 478.96
1 1 4A5X 5 2004-02-19 14:26:3622.1894.17
21.13 470.89 481.05
1 1 4A5X 6 2004-02-19 14:26:3722.1994.17
21.197 472.65 482.89

Type Obs# Label Etime Date Tcham Pressure H2O CO2 Cdry dCdry/dt Flux CrvFit CrvTime Virga Vcham Offset Area Vtotal

474.67 1.645 8.3 90 1.1 19 835.2 3.25 83.7 1126.22
563.51 1.412 7.13 0.0293 30 19 835.2 3.25 83.7 1126.22
171.35 0.005 1.2 1259.3 90 0 0 0 0 0

Raw Records

Header

Summary Records

# of columns in Raw Records
# of columns in Summary Records

Version 1 Format 
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Version 3.2 Footer LI-8100 Data File Format
Version 3.2 of the SoilFluxPro adds multiple flux capability, and this shows up in some 
changes to the footer. In the example below, there are two extra columns (with labels V1 
and CO2), and two extra rows (labels GasColumnID and Dilution). This indicates that two 
extra flux computations were done, using V1 and CO2, in addition to the standard flux 
computation, which is based on CDry. 

Computing a flux for V1 would be done if a second gas analyzer is connected to the 
LI-8100A, with a linearized analog output being fed into channel V1. 

The flux for CO2, without a dilution correction in this case, lets you see the impact of 
evaporation when you neglect it; the flux was reduced to 2.78 from 3.25 in this example. 

When a dilution correction is done (the V1 example), you can pick the quantity used for 
the water measurement, and the multiplier to use to convert that reading into mol/mol. In 
this case, we used the data in the H2O column (units are mmol/mol), along with a multi-
plier of 0.001.

GasColumnID: Cdry V1 CO2
Dilution: none H2O 0.001 none
CrvFitStatus: Exp 2 Exp 2 Exp 2
Exp_Flux: 3.25 3.16 2.78
Exp_FluxCV: 1.12 1.11 1.13
Exp_dCdry/dt: 1.0722 1.0421 0.9163
Exp_R2: 0.9992 0.9994 0.9991
Exp_SSN: 0.3962 0.2621 0.3636
Exp_SE: 0.0031 0.0025 0.0030
Exp_a: 2.54E-03 2.22E-03 1.17E-03
Exp_Cx: 1248.8 1273.1 1595.7
Exp_Co: 826.8 804.2 815.0
Exp_t0: -1.2 -2.4 0.4
Exp_Iter: 2 2 2
Exp_MaxIter: 10 10 10
Lin_Flux: 2.86 2.81 2.62
Lin_FluxCV: 1.18 1.16 1.15
Lin_dCdry/dt: 0.9435 0.9293 0.8651
Lin_R2: 0.9983 0.9988 0.9989
Lin_SSN: 0.8061 0.5605 0.4283
Lin_SE: 0.0044 0.0037 0.0032
Crv_Domain: 80 80 80
Crv_#Smp: 80 80 80
Dead Band: 00:10 00:10 00:10
TimeClosing: 18 0 0
Target: 370.0 0.0 0.0
Flux@Target: 6.76 8.57 5.67
MinCO2: 764.3 766.5 754.5
Flux@Min: 3.73 3.41 2.99

Two new row labels
Potentially more columns
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Continuous Measurements LI-8100 Data File Format
LI-8100 Continuous Measurement data files consist of lines of comma-delimited text, as 
is illustrated below:

File Name: jmw2
Instrument Name:UNKNOWN
Serial Number:81A-0109
Software: 2.a.12
Comments:
Type Etime Date Tcham Pressure H2O CO2 Cdry
1 -1 2006-01-10 12:04:410 97.65 4.768 634.51 637.55
1 -1 2006-01-10 12:04:420 97.59 4.781 633.96 637
1 0 2006-01-10 12:04:430 97.52 4.75 627.32 630.31

: <several lines removed>

Header

Raw Records
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SoilFluxPro Definitions Miscellaneous Topics
SoilFluxPro classifies the variables in LI-8100 files into three types: Header, Measured, 
and Footer. SoilFluxPro adds a few of its own in a fourth type, Miscellaneous.

Miscellaneous Variables SoilFluxPro Definitions
The table below describes the Header variables.

Header Variables SoilFluxPro Definitions
The table below describes the Header variables.

Label Description

Item#

When a file is read, observations are assigned values starting with 
1. They retain this number throughout their life loaded in SoilFlux-
Pro, even if observations are sorted, copy-pasted, etc. This value 
is not retained when a view is written to a file; when that file is read, 
Item# values are again assigned based on the order observations 
are read.

Type
‘Cham’ if a chamber measurement, or ‘Cont’ if a continuous mea-
surement. 

#Msgs
The number of Warnings and Messages. Warnings are -1 TYPE 
records found in the data. Messages may be generated when Soil-
FluxPro reads the file.

#Raw Number of Type 1 records in the observation. 

#Gasses
Number of gasses for which flux computations have been done. 
That is, the number of data columns in the footer. See Version 3.2 
Footer.

ObsDateTime Equivalent to the Date value of the record having ETime = 0.

ObsDOY Day of the Year (fractional) of ObsDateTime. 

ObsDecHr Decimal hour of the day of ObsDateTime. 

HasGPS?
Yes if there are GPS columns (at least Latitude and Longitude) in 
the raw and summary data.

Label Description

LI-8100
5 hexidecimal values giving the size of the header, label, raw data, 
summary data, and footer. (This is no longer used by SoilFluxPro, 
as of version 4.0)
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File Name
The original file name (as stored on the LI-8100) is preserved by 
SoilFluxPro, regardless of how you may rename the Windows files 
that contain this data, or cut and paste observations.

Instrument 
Name

Serial Number

Software
Version of the embedded code in the instrument. If the file has 
been stored by SoilFluxPro, this field will also contain the SoilFlux-
Pro version.

Comment User entered at time of data collection.

Obs# Observation number.

Port# Multiplexer port number. (0 if not using a multiplexer.)

Label User entered at time of data collection.

Observation 
Length

The original observation length.

Observation 
Delay

Wait time between observations. (Renamed in version 3 to Pre-
purge.

Pre-purge Wait time before observations (named Observation Delay in v.2).

Post-purge Wait time after observations (new in version 3).

IRGA Averaging Averaging time for the gas analyzer.

Chamber Model identifier for the chamber used.

TSource Which channel to use for temperature for flux computations. 

Flow8100 Pump setting in the LI-8100 box.

FlowMux Pump setting in the multiplexer box.

Tmux Multiplexer temperature at start of observation

Virga Volume of the IRGA (cm3)

Vmux Volume of the multiplexer (if used) (cm3)

Label Description
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Measured Variables SoilFluxPro Definitions
Summary statistics of measured variables are identified by the column label, and a prefix 
of “IV”, “Mean”, or “Range”. Thus, for example “IV Cdry” means the Type 2 value of the 
Cdry column, and “Range Etime” means the Type 4 value of the Etime column.

Footer Variables SoilFluxPro Definitions
The table below describes the Footer variables.

Vext Volume of extension tubing (cm3)

Vcham Volume of the chamber (cm3)

Offset Offset (cm) used in volume calculation

Area Exposed soil area (cm2)

Vtotal Total volume (cm3)

V1 Info

Information on how the voltage channel is configured: Multiplexer chan-
nel, slope, offset, etc.

V2 Info

V3 Info

V4 Info

T1 Info

Thermocouple type information.
T2 Info

T3 Info

T4 Info

Labels_01 Number of columns in the raw data section

Label Description

CrvFitStatus

Curve fit solution. “Exp” means the exponential fit was better than 
the linear fit (Exp_SSN < Lin_SSN). “Lin” means the linear fit was 
still better after the maximum number of iterations, and the nonlin-
ear coefficients have therefore been derived from linear fit.

Exp Flux Flux computed from Exponential Fit.

Label Description
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Exp_FluxCV Coefficient of variance (%) of Exp Flux

Exp_dCdry/dt Slope of the Exponential Fit at time to. 

Exp_R2 Correlation coefficient for Exponential Fit.

Exp_SSN Normalized sum of squares of residuals for Exponential Fit. 

Exp_SE Standard error (%) of the Exponential Fit.

Exp_a The a term in the Exponential Fit.

Exp_Cx The  term in the Exponential Fit.

Exp_Co
The Co term in the Exponential Fit. Usually the IV value of Cdry, 
but if followed by *, indicates it has been manually set. See Manu-
ally Set Co.

Exp_t0 The to term in the Exponential Fit.

Exp_Iter Number of iterations used in the Exponential Fit.

Exp_MaxIter
Maximum number of iterations allowed for the Exponential Fit. 
This is fixed to 10 in the LI-8100, but can be adjusted in SoilFlux-
Pro.

Lin Flux Flux computed from Linear Fit.

Lin_FluxCV Coefficient of variable (%) of Lin Flux

Lin dCdry/dt Slope of the Linear Fit.

Lin_R2 Correlation coefficient for the Linear Fit.

Lin_SSN Normalized sum of squares of residuals for Linear Fit 

Lin_SE Standard error (%) of the Linear Fit.

Crv_Domain Time span (s) used in the curve fit.

Crv_#Smp Number of data points used for curve fitting.

Dead Band
Time (s) after the chamber closes that are skipped by the analysis, 
in the latest (re-)computation

TimeClosing Time (s) it took the chamber to close.

Label Description

C
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Curve Fitting Details Miscellaneous Topics
The LI-8100 (and SoilFluxPro) fit measured variables Cdry vs. Etime in two ways: the tra-
ditional linear fit, and the theoretically more correct exponential fit.

Linear Fit. Dilution corrected CO2 (C) is plotted against time in seconds (t) and fit by lin-
ear regression.

(5)

where slope m is available as Lin dCdry/dt. Offset b is not available. The correlation coef-
ficient of this fit is available as Lin_R2. The CO2 flux based on this rate is available as 
Lin Flux.

Exponential Fit. Dilution corrected CO2 (C) is plotted against time in seconds (t) and fit 
by a nonlinear regression.

(6)

Co is the starting concentration, and is known (Type 2 value of Cdry). It is also the theo-

retical concentration when t = to. The nonlinear regression solves for , to, and a, 

(The values below are not part of an LI-8100 data file as output by the instrument. 
They are, however, added to the footer of files saved by SoilFluxPro.

GasColumnID
The column label for which flux is computed. The first one will 
always be Cdry. 

Dilution

The column label used for the H2O measurements if a dilution cor-
rection is applied to the GasColumnID flux computation. When 
computing flux for Cdry, this is none, since dilution is already 
accounted for in Cdry. If a column label is specified, it will be fol-
lowed by a decimal value, that represents what was used to con-
vert the value in the water column to units of mol/mol.

Target See Compute Targeted Flux.

Flux@Target Flux at Target (Compute Targeted Flux).

MinCO2 Minimum CO2 during chamber closing.

Flux@Min Flux at MnCO2 (Compute Targeted Flux). 

Label Description

C t  mt b+=

C t  C Co C– e
a– t to– 

+=

C
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which are available as Exp_Cx, Exp_a, and Exp_t0 respectively. The correlation coeffi-
cient of the fit is Exp_R2, the slope at t = to is Exp_dCdry/dt, the standard error of this 
slope is Exp_SE, the CO2 flux based on this slope is Exp Flux, and the coefficient of vari-
ation of this flux (in %) is Exp_FluxCV.

The data sets are the same for both fits, and is some subset of the Raw Records. There 
is a dead band (Dead Band) of user-defined length to allow for complete mixing in the just-
closed chamber (SoilFluxPro also refers to this as a Start time). The LI-8100 uses all of 
the raw records after the start time / deadband, but SoilFluxPro allows you to shorten this 
by specifying a stop time. How much data you fit is available as Crv_Domain of the num-
ber of seconds, and Crv_#Smp for the number of data points.

Exp_Iter reports the number of iterations that the nonlinear regression took, which typi-
cally is less than 5. If the regression takes the maximum number of iterations 
(Exp_MaxIter - set via Recompute)and still hasn’t converged, then the normalized sums 
of the squares of the residuals are compared (Lin_SSN and Exp_SSN) to see which gave 
the better fit. CrvFitStatus reports the result as “Lin” or “Exp”. “Exp” means the nonlinear fit 
had lower residuals than the linear fit, and “Lin” means the linear fit was better. When-
ever “Lin” is reported, note that the nonlinear coefficients are set as follows, based on the 
linear fit:

(7)

“Lin” usually indicates something strange with the data, such as a kink in the time series 
of Cdry - not uncommon in gusty conditions with a less than perfect chamber vent 
design.

C 1
610=

t0
C0 b–

m
---------------=

a
m

C C0–
--------------------=
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Preferences Miscellaneous Topics
The Preferences Dialog allows you to modify the tool bar appearance. 
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